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Dingbat DesignWorks: Swirled Stars
4 BERNINA’s PaintWork and CrystalWork Tools are fantastic for embellishing 

knits! Try these DesignWorks techniques on a garment that is in need of 
a makeover, whether it’s one already in your closet or a bargain from a 
secondhand store. 

Scrappy “Orphan Block” Placemats
7 Joan Ford accepted our challenge to create a set of fun, fresh placemats 

using only “orphan” quilt blocks and fabrics from her stash. We love her 
solution, especially the “wonky” altered squares! 

Woodland Fantasy
10 A delicately hand-painted silk handkerchief purchased at a thrift store was 

the starting place for Carol Collett’s fabric and fiber “painted” Woodland 
Fantasy. 

Stencil It!
12 Peggy Johnson shows how to make your own unique painted signs using 

BERNINA’s CutWork Software and Tool to cut custom-designed stencils.

Indigo Blossoms Desk Set
14 Just because you work there doesn’t mean your desk can’t be a beautiful 

place. Embellished with elegant “Indigo Blossoms” embroidery, this denim 
desk set is pretty as well as functional.

Featured Accessory: Needle Punch Accessory Set
18 Traditionally a hand-worked technique, needle-punch by machine is a free-

motion technique that is much faster to craft by machine. It’s like painting 
with fibers!

Farmers Market Tote Bag
20 This cute Farmers Market Tote Bag is easy to make! Start with an old pair 

of pants – cuffed or uncuffed – and a half-yard of fabric for the ruffles. You 
don’t even have to hem the top of the bag – it’s the hem of the pants leg!

The Last Word
23 Valuable coupons, a list of quick links, and a sneak peek inside the next  

issue of Through the Needle ONLINE.
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did you know?
If you see this symbol, 

simply click on it to 

view a video 
on related 
material!

Errata
In “Magical Paradox,” 
TTNO Issue 15, please 
substitute Wave Fill for 
Ripple Fill in the chart on page 4 and 
the checkerboard instructions on page 
5. We apologize for any confusion this 
error may have caused.
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Spring is here! Well, almost. It’s cold and dreary outside – the perfect time for sewing space spring cleaning. You never 
know what you’ll find when you start going through boxes and closets, and we have some clever ideas for making use 
of the items you uncover.

For instance – do you have a collection of mismatched quilt blocks? Maybe leftovers from finished quilts, or projects you 
started but never finished? Even sample blocks work well for Joan Ford’s Scrappy “Orphan” Block Placemats. They don’t 
even have to be the same size, as you’ll trim them to match.

If you’re like me, you probably have a stash of pretty yarns, fibers, fabric snips, and other treasures that you’ve been 
saving – but don’t know what you’ll ever use them for. A beautifully-painted silk scarf was the starting point for Carol 
Collett’s Woodland Fantasy, which is a masterpiece of needle-felting and free-motion stitching. She shares tips for 
needle-felting with BERNINA’s Needle Punch Accessory Set – it’s like painting with fibers!

Do you have a favorite pair of pants that’s no longer wearable because they’re stained, damaged, or out of style? Bring 
them back as a durable tote following Timmesa Eads’ Ruffled Farmers Market Tote instructions. Or perhaps you have 
a shirt or sweater in need of revitalizing? BERNINA’s new PaintWork and CrystalWork Tools are super for embellishing 
knits, as they don’t affect the stretchability of the garment. Amanda Whitlatch shows how to create fun designs from 
computer fonts in her DesignWorks Dingbats: Swirled Stars tutorial. Of course, these techniques are also wonderful for 
newly-made (or purchased) garments, too.

Jo Leichte 
Editor

Project by Juliette Lanvers

These cute hair ties can be made in any combination of colors and textures. 
Made out of felt, they are easy to sew. Can’t use a hair tie? Transform one into 
a brooch for your lapel!

Winter Flower Hair Ties

What to do once your sewing space is neat and tidy? How about adding a personalized 
sign or two? Peggy Johnson shows how she created “Sew Creative” stencil templates 
and painted a custom-designed sign for her new store. And in anticipation of April 
showers bringing May flowers, stitch some pretty posies for your workspace with 
Denise Jones’s Indigo Blossoms Desk Set instructions. Oh-so-pretty, but functional, too – 
and denim ensures that it’s durable as well.

Happy sewing! Jo

http://weallsew.com/2013/01/31/winter-flower-hair-ties-by-juliette-lanvers/
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by AMANDA WHITLATCH

DesignWorks Software Suite and the PaintWork 
and CrystalWork Tools from BERNINA are 
fantastic for embellishing knits! The paint and 
crystals are applied only to the surface of the 
fabric, so they don’t prevent the knit from 
stretching. And the back of the fabric stays 
clean, with no stabilizer remaining on your 
finished project.

Try these DesignWorks techniques on a garment 
that is in need of a makeover, whether it’s one 
already in your closet or one that you find on 
sale at a bargain price or in a local secondhand 
store. This is a great way to hide a stain or mark 
on a garment that you really like! 

Supplies
•	DesignWorks Software Suite  

(with Paint and Crystal activated)

•	PaintWork Tool

•	CrystalWork Tool

•	OESD StabilStick stabilizer

•	Edding Textile Pens

•	Parchment paper

•	Template material

•	Transfer tape

•	Backing board

•	SS 10 heat set crystals (about 100 for each star)

If you are looking for design ideas and graphics to 
use with your new DesignWorks Software, fonts 
are the place to start! Not just “word art” created 
with beautiful lettering styles, but also graphic fonts, 
commonly referred to as Dingbat fonts. The term 
“dingbat” is used in the computer industry to describe 
fonts that have symbols and shapes in the positions 
designated for alphabetical or numeric characters. (Click 
HERE to see a Wikipedia article on dingbats.)

To install additional fonts on your computer, you must 
first download them from a software program or the 
Internet. Use caution when downloading fonts; many 
sites contain malware, so be careful what you click on. 
One reputable site I enjoy is Dafont.com, where you’ll 
find a vast selection of free and donationware fonts.

Caution: Loading too many fonts can slow down your 
computer. If applications run slowly, or a font dropdown 
menu takes a long time to load, it might be time to 
delete a few fonts. There is no hard and fast rule that 
determines how many fonts are too many; it depends 
on the size of the font files, the amount of computer 
memory available, and the type of processor in your 
computer. 

Download the Dingbats Font
The project shown uses a font from Dafont.com, but 
feel free to substitute other dingbats of your choice. 
The procedure below should work with any fonts you 
wish to download.

DesignWorks
PROJECT

Dingbat DesignWorks:
Swirled Stars

http://weallsew.com/author/amandawhitlatch/
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Software-us/BERNINA-DesignWorks-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Software-us/BERNINA-DesignWorks-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-accessories-for-embroidery-machines-us/BERNINA-PaintWork-Tool-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-accessories-for-embroidery-machines-us/BERNINA-CrystalWork-Tool-us
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBSSC39-15
http://www.edding-creative.com/kategorien/kategorie/textilmarker/produkt/textilien_texter_der_edding_4600_textile_pen.html
http://en.wikipedia.org/wiki/Dingbat
http://en.wikipedia.org/wiki/Dingbat
http://www.dafont.com/
http://www.dafont.com/
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Click on the Rectangle Select icon. Using the Corner 
Sizing handles, click and drag to enlarge the design.

From the upper Tools dropdown menu, select Options. 
In the General tab, select U. S. for Measurement 
System; click OK. With the design selected, enter 4.5 
for Width and Height.

Click the Hoop icon and select Center to Hoop > OK.

With the object selected, click in the lower right corner 
of a color chip (fill) in the Brushes palette, and then in 
the top left corner (outline). The outline will smooth the 
rough outer edges of the fill.

Click the Save icon and name the file Swirling Star. 
Navigate to the folder in which you wish to save the 
design, then click Save.

Click the Export icon to send the design to the machine 
or USB stick.

Create a Coordinating CrystalWork Design
Select the Create Freehand Shapes tool. Click and draw 
a curved line in one leg of the star.

Select the Edit Shape Nodes icon. Drag the arrows 
and move the nodes until you have a pleasing crystal 
placement line.

Download the Hearts and Stars font from Dafont.com, 
and save the ZIP file on your computer. Right click on 
the zip folder icon, click the Extract All option, and click 
Browse to select a location for the unzipped folder. (If 
you do not select a location, the files will unzip to the 
same directory as the original ZIP folder.)

Tip: If you aren’t sure where you saved the file, click on 
the Start Menu and type the folder’s name in the Search 
box.

A progress bar will appear on screen, and an "estimated 
time left" during the unzipping process will be shown. 
Once completed, the unzipped folder will open in a 
new window, and you can begin working with the files 
contained in it.

Install the Font

Windows 7 / Vista
•	Browse to where 

the font file is saved. 
Right-click on the 
font file and select 
Install.

Windows XP
•	On your computer, 

click the Start button 
and select Control 
Panel > Appearance and Personalization > Fonts.

•	Click File > Install New Font. (If you don’t see the File 
menu, press the ALT key.)

•	In the Add Fonts dialog box, under Drives, click the 
drive where the font you want to install is located.

•	Under Folders, double-click the folder containing the 
desired font.

•	Under List of Fonts, click the font and then click 
Install.

Digitize the PaintWork Star 
Open DesignWorks software.

Select Create New > Next. In the Fabric dialog box, 
click Next for the default selection. Select New Graphic 
by clicking the radio button. Under Hoop, use the 
dropdown box to select the BERNINA Large Oval Hoop, 
255x145, #43. Click Finish.

Click the Hoop icon and select the BERNINA Large Oval 
Hoop, 255x145, #43. Click OK.

Click on the Text icon. In Tool Options, select Hearts and 
Stars.

Click in the workspace and press the letter Q on the 
keyboard.

Click on the Rectangle Selection icon. Using the Brushes 
palette, assign and outline color to the freehand line 
shape.

In Object Properties, select the Crystals icon. For 
Spacing, enter 2.0.

Click on the appropriate crystal to change the color.

Select the Create Circular Array icon. For Step Count, 
enter 5. For End Angle, enter the same value that is 
displayed for Start Angle. This creates a full rotation. 
Don’t worry if the designs do not align.

http://www.dafont.com/
http://windows.microsoft.com/en-US/windows-vista/Install-or-uninstall-fonts
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Click on Apply Circular Array to set the duplicates in 
place.

Click in an empty area of the workspace to deselect 
them.

Select the individual pieces and move them into position 
over the graphic. Nudge them into place using the 
arrow keys on the keyboard.

Rotate each piece of linework as needed. To 
do so, hover the cursor over the corner of 
the design until it becomes a rotation cursor, 
then rotate it into place. 

Complete these adjustments for each design over the 
legs of the star. 

Select the Circle tool. Click and drag a circle, starting at 
the star center and dragging outward, holding the Ctrl 
key to create a perfect circle.

Click the Rectangular Select icon and move the circle 
over the star center. Resize if necessary.

In Object Properties, select Crystals for Fill. For Fill Style 
select Circular Fill. Click on the Outline tab (pencil) and 
for Line select None.  Reselect the Fill tab (bucket) and 
select a color.

Adjust the size as 
needed and move 
the object into 
position over the 
star center.

For H. spacing, 
select 2.0 mm. 
Click the Save 
icon.

To Export the Crystal design select File > Export > 
Crystals to Machine. In the Export to Machine dialog 
box select the Export icon to send the CrystalWork 
design to a USB stick or machine.

The finished design is approximately 5” square. Use 
it to embellish a project or garment, following the 
instructions included with each accessory to execute to 
the design.

Don’t want to digitize your own designs?
Download Amanda’s Swirling Stars at  

bernina.com/ThroughTheNeedle

http://www.bernina.com/en-US/Experience/Through-the-Needle-Online


What is an Orphan Quilt Block? When I’m working on a 
scrappy quilt, I often make a few extra blocks. The ones 
that don’t make the cut for the main quilt project are 
“orphans.”

For my placemat challenge I started by looking for a 
focus print that would coordinate – or maybe just not 
clash – with my blocks. I also looked for a cheerful – but 
neutral – print and a white, cream or solid connector 
fabric for the narrow sashing that would join and frame 
the blocks. . My orphan blocks didn’t match the focus 
print (from the Bold & Beautiful – Breezy collection 
by Benartex) perfectly, but that was okay. Overall, the 
blocks “read” cool and 
scrappy. The cool tones 
in the focus print I chose 
provide a resting place from 
the chaos of the scrappy 
blocks, and the cream 
connects the blocks to each 
other nicely.
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Scrappy

by JOAN FORD

qui l t ing
PROJECT

Placemats
The challenge: Adding 
only fabrics from your 
stash, create a set of 
placemats with a fresh, 
playful look. 

My orphan blocks were  
9” square. Since I wanted to 
make placemats with a simple 
setting of two rows of three 
blocks, the blocks required 
trimming to make them work. I 
marked my 7” ruler at the 5½” 
lines using two pieces of Cutting 
Edge by QTools to create a kind 

of template that would make it easy to trim the blocks.

To keep things playful, 
I cut all my blocks at 
different angles. First, I 
cut along the right and 
top edges of the ruler/
template. (Lefties: Rotate 
the ruler 90° and cut 
along the left and top 
edges.)

"Orphan Blocks"

http://scrap-therapy-quilts.blogspot.com/
http://www.youtube.com/watch?v=0Pnld-Rjsr8
http://www.youtube.com/watch?v=0Pnld-Rjsr8
breezy = http://benartex.com/page/page/index.php?page=gallery-detail&collection=331
breezy = http://benartex.com/page/page/index.php?page=gallery-detail&collection=331
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For extra-narrow sashing strips 
like these, I like to pin liberally. 
I placed the sashing strip under 
the right side of the block. 
You can’t see it, but it’s there! 
I promise. Placing the sashing 
on the bottom prevents the 
wonky seam allowances from 
interfering with the feed dog when I stitched the  
¼”-wide seams to join the blocks and sashing strips.

After stitching the short sashing strips between pairs of 
wonky squares, I pressed the seam allowances toward 
the sashing, and then stitched one side of each long 
sashing strip to the long edge of a wonky pair.

TIP: For perfect ¼”-wide seam allowances, use a 
quarter-inch foot such as BERNINA Patchwork Foot 
#37/37D or Patchwork Foot with Guide #57/57D.

Before pinning and sewing the other side of the sashing 
strips, I took a quick peek to make sure the short 
sashing strips lined up nicely. I wanted the blocks to be 
wonky, not the seam intersections!

This is where the Cutting Edge really has an impact! 
After rotating the block 180˚, I positioned the ruler with 
the Cutting Edge markers butting up against the cut 
edges of the block. Again, I cut along the side and top 
edges.

I now had a perfectly 
wonky – but still 
perfectly square – 
altered orphan block!

I repeated the process 
one block at a time to 
make six 5½” square 
“wonky blocks” for 
each place mat.

TIP: You’ll have a bit of a scrap pile left. If you are an 
animal lover, put your fabric scraps in an old pillow 
case. Once it’s full, edgestitch the pillow case closed 
to make a cozy animal bed and donate it to your local 
animal shelter. 

From the cream fabric, I cut 1”-wide sashing strips, six 
5½” long and four 11” long. Making more than two 
placemats? You’ll need three 5½”-long strips and two 
11”-long strips for each additional placemat. 

Next, I arranged the blocks and sashing strips as shown 
below.

Perfect!

For the inner borders I cut additional 1”-wide cream 
strips – two 16½”-long and two 12”-long strips for 
each placemat. I added the long strips first, then the 
short ones, pressing the seam allowances toward the 
borders after each addition.

http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/-37D
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/-37D
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/-57D-with-guide


At the opening, I carefully turned the batting, backing 
and pieced top under and pinned liberally (every 1” 
or so) to keep all the bulk and raw edges inside. (See 
all the extra straight pins at the bottom edge?) A few 
safety pins in the center held the layers together.

For the outer borders I cut 2”-wide strips of the focus 
print. Instead of measuring the length of each border 
with a ruler, I let the placemat top “tell” me how long 
the strips needed to be by placing the strips on the 
pieced top and trimming the ends even. (About 17½” 
for the long edges and 15” for the short edges.)

As I did for the inner borders, I pressed the seam 
allowances toward the borders after each addition. 

To complete each 
placemat I made a  
“quilt sandwich” using 
a 16” x 21” piece of 
batting, with an  
18” x 24” piece of  
my focus fabric on top, 
right side up. Then I 
placed the pieced top 
right side down on top 
of the rectangle of focus 
fabric so I could sew the 
pieces together “pillowcase-style.”

TIP: When I make small projects in this “pillowcase” 
style, I often use the same fabric for the backing 
and the border. That way if a little bit of the backing 
material peeks over the edge, it’s not as noticeable as 
a different fabric would be. As a bonus, this makes 
my placemats reversible! An embarrassing spill at the 
dinner table is easily hidden with a quick flip!

After pinning around the edges 
of each placemat, I stitched 
¼” away from the edge of 
the pieced  placemat top, 
leaving an 8” opening along 
one long edge for turning. 
Then I trimmed the batting and 
backing even with the edges 

of the pieced placemat top, and clipped the corners to 
reduce bulk.

I turned the placemat 
right side out through 
the opening, then 
pinched and pinned 
the edges all the way 
around. (I know, this 
seems like a bit much, 
but…oh, well!) 

Joan Ford
Joan Ford is the author of 
the popular ScrapTherapy® 
pattern series and 
books. Her second book, 
ScrapTherapy® Scraps Plus 
One! from The Taunton 
Press goes on sale in 
April 2013. Visit her 
website, Welcome to the 

Hummingbird Highway, and blog, Winging It! at the 
links below.

http://scrap-therapy-quilts.blogspot.com/
http://hummingbird-highway.com/

After choosing a 
decorative stitch and 
attaching a walking 
foot to my machine, 
I stitched close to the 
outer edge – all the way 
around the perimeter 
of each placemat – far 
enough from the edge 
to keep them from 
falling off the edge. 
The decorative stitch 
compresses the extra 
bulk of the seam allowances, and at the same time 
closes the opening. No need to hand-stitch it closed!

After stitching-in-the-ditch around the borders, I 
stitched random lines over each block to quilt the layers 
together. Ta-da! Finished!
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http://scrap-therapy-quilts.blogspot.com/
http://hummingbird-highway.com/
http://www.amazon.com/ScrapTherapy-Scraps-Plus-One-Patterns/dp/1600855199
http://www.amazon.com/ScrapTherapy-Scraps-Plus-One-Patterns/dp/1600855199


The beautiful needle-felting art created by fiber artist 
and author, Margo Duke, inspired the creation of my 
Woodland Fantasy quilt. The needle felting process 
for my quilt was accomplished using the BERNINA 
Needle Punch Accessory. When installed on my sewing 
machine, this tool enables me to create a quilt as if I 
were painting with fabric and fibers. 

Having no final design in mind, I began Woodland 
Fantasy as a small practice project. First, I selected 
a focus fabric – a delicately hand-painted silk scarf 
purchased at a thrift shop. The design in the scarf 
suggested a quilt with an organic nature, so I continued 
by auditioning a variety of other types of fabric that 
complemented the focus piece. Next a 9” x 12” 
rectangle of water-soluble fabric was cut to form the 
base for my felted piece. I cut a leaf section from the 
scarf, placed it on the stabilizer, and slowly needle 
felted it. I cut free-form shapes from the other fabrics 
and continued to needle-felt them to the base until 
the stabilizer was completely covered. The piece had a 
truly organic feel after the felting was completed. Next, 
I chose a variety of textured yarns and fibers and felted 
these primarily over the raw edges of the fabric. 

I learned quickly that all fibers do not felt well! So I 
put those aside to couch with thread later. Once I was 
satisfied with the needle felting I removed the needle 
felting tool, returning my BERNINA to a regular sewing 
machine. I then used monofilament thread to couch 
several fibers that could not be felted to the piece.

I was very pleased with the outcome of my practice 
piece. At that point, I wasn’t sure how I would use the 
piece – would it become the front of a purse or a quilt? 
Since the piece was much too delicate for a purse, I 
decided to make a quilt. 

by CAROL COLLETT

needle
FELTING

I loved the organic nature of my felted piece and did 
not want to disrupt the irregular edges by squaring it 
with a rotary cutter. Instead, I placed the felted piece on 
a black background fabric. Because I did not want to 
disturb the lovely texture of the felted piece with heavy 
quilting, I first constructed and completely quilted the 
black quilt background. The irregular black borders, 
2” to 3” wide, which continue the organic nature of 
the felted centerpiece in the finished design, add to 
the organic appeal. Once the black background was 
completely quilted, the felted piece was positioned 
on top. I then strategically placed pieces of coffee-
dyed cheese cloth around the edges of the felted 
piece, forming a transition between the needle-felted 
quilt and the irregular quilted border. Using primarily 
monofilament thread, I stitched the felted piece to the 
black quilt background. To embellish the piece I did 
free-motion stitching with metallic thread in several 
sections of the quilt. To finish, I faced the outer edges.

Then the fun commenced! My final embellishments 
include needle lace butterflies and leaves, hand-dyed 
silk ribbon, beads, and ready-made butterfly appliques 
and leaves.

Woodland 
Fantasy
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http://ccscreativecove.blogspot.com/
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-rotary-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-rotary-hook-machines-us
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Needle Felting Tips
•	I always needle felt at a relatively slow speed to 

minimize the possibility of needle breakage. It takes a 
little more time, but in my opinion it is worth the slow 
pace.  

•	Natural fibers felt better than synthetics.

•	Needle-felted pieces will shrink during stitching, so 
plan ahead if you have a desired final size in mind.

•	If you plan to remove the stabilizer by immersing 
a needle-felted piece in water, first heavily stitch 
the needle felting. (Note: I chose not to immerse 
Woodland Fantasy in water; the water-soluble 
stabilizer created a soft base and remains in the quilt.) 

The needle-felting process is very serendipitous and 
artistally versatile. I encourage everyone to experiment, 
using fabric and fibers to paint with the BERNINA 
Needle Punch Accessory. If you needle-felt fabric or 
fibers you don’t like, you can simply pull them off the 
base and continue working with your piece. 

Carol Collett
Carol Collett is a national award-
winning quilter, fiber artist, and 
teacher who resides in Scottsdale, AZ. 
She developed a passion for sewing 
at the age of seven and made her first 
quilt in 1993. Carol’s talents extend to 
quilt making, mixed media, wearable 

art, and doll making. She has won numerous ribbons 
since 2000 in Arizona Quilt Guild Shows, and in 2001 
she won First Place in a national quilt contest sponsored 
by Quilts and Other Comforts. In 2004 she won a ribbon 
at the NQA Show, and was a finalist in the national 
2006 $100,000 Quilting Challenge. Her work has been 
published in American Quilter, Haute Handbags, and 
Apronology. Carol has taught at Arizona quilt shops, the 
American Sewing Guild, and Quilt Camp in the Desert.  
Carol has been a long-arm quilter since 2005.
http://ccscreativecove.blogspot.com
http://www.sewfromtheheart.com

http://ccscreativecove.blogspot.com/
http://www.sewfromtheheart.com/
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-CB-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-CB-hook-machines-us
http://www.bernina.com/en-US
http://www.rickytims.com/seminars
http://www.rickytims.com/seminars
http://arizonaquiltershalloffame.org/index.php?option=com_content&task=view&id=103&Itemid=60
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by PEGGY JOHNSTON

CutWork
PROJECT Stencil It!

When I moved into my new store, I wanted the 
printing on my cash station to coordinate with 
that on my outdoor sign. So I found a similar 
font, digitized SEW CREATIVE using BERNINA 
CutWork Software, cut stencils using the 
BERNINA CutWork Accessory, and painted the 
front of the cash station. It’s beautiful and you 
can use my method to create stencils for painted 
projects of your own!

Supplies
•	BERNINA CutWork Software and Accessory

•	CutWork-compatible embroidery machine

•	Appropriate CutWork Stitch Plate for your machine

•	Echo-Quilting and Cutwork Foot #44

•	Jumbo Hoop (or your largest embroidery hoop)

•	Kittrech® Magic Cover® Clear Self-Adhesive Vinyl

•	Scotch™ Satin Tape

•	Stencil blanks (available at hobby stores)

Digitize the Lettering
Open the CutWork software. In the New Design dialog 
box, click on the Create New button and click Next.

In the Artwork Source dialog box, click on the New 
Graphic button, select Jumbo Hoop #26 (or your largest 
hoop) and click Next.

Select a color in the Fabric dialog box (the fabric weight 
does not matter) and click Finish.

Click on the Hoop icon and select the 256 x 400 mm 
#26 Jumbo Hoop (or your largest hoop). Check the box 
to rotate it 90 degrees, select Center, and click OK.

Select View > Toolbars > Tool Options, and select a font 
from the dialog box. I selected Curlz MT, a TrueType 
font on my computer, which matched the style of the 
lettering on the sign in front of my shop.

Click on the Edit Text icon, click inside the hoop, and 
enter your text. For my sign I split the words and made 
two stencils: SEW and CREATIVE. 

before

after

http://www.sewcreative.com/
http://www.sewcreative.com/
https://www.facebook.com/pages/Sew-Creative-Peoria-Heights/158452290832996
http://www.bernina.com/en-US/Products/BERNINA-products/BERNINA-Software/BERNINA-CutWork-us
http://www.bernina.com/en-US/Products/BERNINA-products/BERNINA-Software/BERNINA-CutWork-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-accessories-for-embroidery-machines-us/BERNINA-CutWork-Tool-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-accessories-for-embroidery-machines-us/BERNINA-CutWork-Tool-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Echo-quilting-and-CutWork-foot-44C-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-accessories-for-embroidery-machines-us/Jumbo-Hoop-us
http://www.kittrich.com/brands/magic-cover/
http://solutions.3m.com/wps/portal/3M/en_US/GovernmentSolutions/Home/ProductInformation/Online_Catalog/?PC_7_RJH9U5230GO250IANS2O1A3I71000000_nid=GS89VL2W39gsWSFF0BLZJ8glGSJC5TX3WSbl
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Carefully apply stencil paint following the instructions 
on the package. I used three colors: white, red, and 
black.

Click on the Rectangle Selection icon, and then click on 
the word to select it.

If the Object Properties dialog box is not visible, select 
View > Toolbars > Object Properties. Click on the 
CutWork icon to change the properties from running 
stitch to cutwork. It’s not necessary to select a running 
stitch; to cut a stencil you need only the cutting 
command.

Save your design as a .DRAW file and then click the 
Export icon to write the file to your embroidery machine 
or USB stick.

Cut the Stencil
Set up your embroidery machine for cutwork following 
the instructions included with the CutWork Accessory. 

Hoop a layer of Magic Cover, printed paper side up, just 
as you would hoop a paper-backed adhesive stabilizer. 
The vinyl side is clear; this allows you to see through 
it and to see through the stencil when you place it on 
your project.

With the Magic Cover secure and tight in the hoop, 
score the paper and peel it away to reveal the sticky 
surface. Place your blank stencil on top, making sure it 
is centered and straight in the hoop. 

Tip: Use the hoop nearest in size to the stencil you are 
cutting. I was able to cut SEW in the Large Oval Hoop 
and CREATIVE in the Jumbo Hoop.

Attach your hoop to your machine (the vinyl side will be 
against the embroidery module). 

Open the .DRAW file. 
Begin cutting your stencil, 
following the on-screen 
prompt to cycle through 
all four blade positions. 
Be careful that the presser 
foot does not become 
tangled in the loose stencil 
material, as it is cutting 
through tape and the 
stencil edges may start to flip up.

Save any inside pieces, such as the bits cut from inside 
the letters A and B. You’ll need them later on, to tape 
inside the letters when you paint your stencil.

Stencil Your Sign
Using satin tape, secure your new stencils to your 
project; in my case, a blank sign with a thread spool 
border. Don’t forget to tape the inside pieces in place, 
too, such as the shape inside the letter A.

I love the look of my new cash station!

Peggy Johnston
Peggy Johnston, owner of 
Sew Creative, located in Peoria 
Heights, IL, opened her BERNINA 
dealership in June, 2000. Prior to 
that she was a Labor and Delivery 
Nurse and witnessed ”creation” 
of a different type every day. Even 

though babies are her first love, sewing was always 
her passion before it became her next profession. 
She started creating embroidery patterns in the 
mid 90’s with the Deco scanner and BERNINA’s 
first embroidery software, Deco Wizard. When she 
became a Dealer she quickly fell in love with the 
features of the artista Software and still loves to use 
all of the BERNINA software. She just wishes she had 
more time to create!

This past year Peggy had to be extra creative and 
energetic as she relocated her business down the 
street into a house 
she converted into a 
real “Sew Creative” 
home.

https://www.facebook.com/pages/Sew-Creative-Peoria-Heights/158452290832996
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by DENISE JONES

Supplies
•	OESD Crafter’s Collection #21006 Indigo Blossoms, 

designs #21006-13, -17, -30, and -31
•	Office supplies: desk calendar, composition notebook, 

and pencil holder
•	Foam core board cut to desk calendar size 
•	1½ yards 60”-wide lightweight blue denim
•	2/3 yard 60”-wide lightweight white denim
•	2 yards Pellon 808 Craft Fuse
•	1 yard Pellon 987F Fusible
•	OESD HeavyWeight Cut-Away Stabilizer
•	OESD StabilStick Cut-Away Stabilizer
•	OESD Isacord thread, colors #0015, 3900, 3910,  

and 3962
•	Chalk marker
•	Fabric glue
•	Mary Ellen’s Best Press 

•	Freezer paper
•	505 Temporary Adhesive Spray
•	edding 4600 textile pen
•	Navy thread for construction
•	Large Oval Hoop and its plastic template
•	Teardrop Darning Foot #26
•	Patchwork Foot #37/37D
•	Walking Foot #50
•	Bias Binder Attachment #88 with Foot #95/95
•	PaintWork Tool #93

Prepare all fabric by pressing with Mary Ellen’s Best 
Press; this will give the denim more body, making it 
easier to work with while constructing the desk set.

embroide ry
PROJECT

Indigo Blossoms 
Desk Set

Just because you work there doesn’t mean your 
desk has to be plain and dull. Embellished with 
elegant “Indigo Blossoms” embroidery, this 
denim desk set is pretty as well as functional, 
creating a beautiful workspace that is sure to 
inspire your creativity.

2/3

http://www.bernina.com/en-US/Products/BERNINA-products/BERNINA-Design-Collection/BERNINA-Exclusive-Embroidery-Collections/Indigo-Blossoms
http://www.bernina.com/en-US/Products/BERNINA-products/BERNINA-Design-Collection/BERNINA-Exclusive-Embroidery-Collections/Indigo-Blossoms
http://pellonideas.com/products/1007-808-craft-fuse.aspx
http://pellonideas.com/products/1055-987f-fusible-fleece.aspx
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBC25-15
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBSSC39-15
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://maryellenproducts.com/Best-Press-Lavender-Fields-The-Clear-Starch-Alternative.html
http://www.embroideryonline.com/products/ItemDetail.aspx?ItemCodeID=321
http://www.edding-creative.com/kategorien/kategorie/textilmarker/produkt/textilien_texter_der_edding_4600_textile_pen.html
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-accessories-for-embroidery-machines-us/Large-oval-hoop-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Embroidery-foot-26-drop-shaped-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/-37D
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Three-sole-walking-foot-50-with-seam-guide-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Binder-attachment-88-for-unfolded-bias-tape-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/-95C
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-accessories-for-embroidery-machines-us/BERNINA-PaintWork-Tool-us
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TIP: When hooping thick layers like this be sure to 
loosen the screw on the hoop enough so that when you 
push the top hoop down into the outer hoop it will not 
leave a hooping mark on your fabric. 

Select from OESD Crafter’s Collection #21006 Indigo 
Blossoms. Send to machine using BERNINA Embroidery 
Software 6, BERNINA Artlink 6, or USB Stick.

Embroider Indigo Blossoms design #21006-13 on the 
journal front.

TIP: Trimming all jump threads between color changes – 
rather than waiting until the complete design is stitched 
– produces a much neater embroidery sew-out. 

Cutting Instructions
Journal Cover
•	Cut four 12” x 17½” rectangles of lightweight blue 

denim.

•	Cut approximately 3 yards of blue denim bias strips 
for binding. (This is enough for the journal cover and 
the pencil cup wrap.)

•	Cut one 12” x 17½” rectangle of Pellon 987F Fusible 
Fleece.

•	Cut two 12” x 17½” rectangles of Pellon 808 Craft 
Fuse.

•	Cut two 8¾” x 12” rectangles of Pellon 808 Craft 
Fuse.

Desk Blotter/Calendar
•	Cut eight 5¼” squares of lightweight blue denim.

•	Cut eight 4¾” squares of Pellon 808 Craft Fuse.

•	Cut two 4¾” squares of Pellon 987F Fusible Fleece, 
and then cut them in half on the diagonal.

•	Cut one rectangle of lightweight white denim  
4” deeper and wider than the desk calendar.

Pencil Cup Wrap
•	Cut two 5½” rectangles of lightweight blue denim

•	Cut two 5½” rectangles of Pellon 808 Craft Fuse

•	Cut one 5½” rectangles of Pellon 987F Fusible Fleece

Journal Cover
Fuse two 12” x 17½” pieces of Pellon 808 Craft Fuse to 
the wrong side of two 12” x 17½” rectangles of denim.

Fold and press the other two denim rectangles in half; 
crease, then open. Fuse a 12” x 8¾” piece of Craft Fuse 
to the wrong side of one half of each denim rectangle. 
These will become flaps to hold the composition 
notebook in place.

Fuse the 12” x 17½” piece of Pellon 987F Fusible Fleece 
to the Craft Fuse side of one of the 12” x 17½” denim 
rectangles. This will be the front cover of the journal; 
the other large denim rectangle will be the lining. 

Fold the journal front in half to 12” x 8¾”, and then 
mark the fold with chalk. Mark a second line 5” from 
and parallel to the first line. Mark a line 6” from the 
bottom edge. The crossed lines mark the center of the 
embroidery design.

Cut a piece of OESD HeavyWeight Cut-Away Stabilizer 
large enough to hoop. Spray with 505 Temporary 
Adhesive and apply it to the back of the area to be 
embroidered. Hoop, aligning the marked lines with the 
plastic template gridlines. 

Cut a 10¾” x 16” rectangle of freezer paper for a 
journal cover template. Create smoothly rounded 
corners by tracing the end of a large thread spool or 
other small circular item. 

Press the freezer paper template, shiny side down, onto 
the embroidered journal cover.  Layer the lining behind 
the embroidered piece. With the template side up, trim 
around the template.

Fold the journal cover in half to find the center; crease. 
This marks where the spine of the notebook will be. 
Straight stitch along this line. 

Place the flaps under the trimmed front/lining, with the 
folds toward the center and 2” apart.
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Trim the flaps to the size of the cover. Stitch around the 
outside edges using Walking Foot #50 and a zigzag 
stitch with a length of 1.4 mm and width of 2 mm.

Bind the outer edges of the journal cover using Bias 
Binder Attachment #88. (Alternatively, bind the edges 
with a traditional double-fold binding.)

Desk Blotter/Calendar
Fuse 4¾” squares of 
Craft Fuse to the 5¼” 
squares of blue denim. 
Fold and press four of 
these pieces on the 
diagonal, then fuse 
the four fusible fleece 
triangles to them. 
Using chalk, mark 
each folded triangle 
¼” from all three edges, and then mark a line from the 
point to the center of the folded side.

Print a paper template for design #21006-30.

Hoop a piece of CutAway Stabilizer in the Large Oval 
Hoop. Spray the back of one corner piece with 505 
Adhesive and place it on the stabilizer. Using your 
embroidery machine’s placement features, align the 
center of the design with the needle; the line from the 
point to the center of the fold marks the center of the 
design. If available, stitch a basting box around the 
design. Embroider the design. Repeat, embroidering 
one for each corner.

Pin each embroidered 
corner square right sides 
together with a plain 
square. Cut away the 
non-embroidered corners 
2” from the diagonal  
fold line.

Stitch around the edges using a ¼”-wide seam 
allowance and leaving the trimmed corner edge 
open. Trim the corners, turn right side out, and push 
the trimmed corner back inside to make a triangular 
“pocket.” Press flat. Repeat for each corner piece.

PaintWork (optional)
Cut a piece of OESD StableStick Cut-Away Stabilizer 
to fit the Large Oval Hoop. Hoop with shiny side up, 
and then score and remove the paper backing.

Print a paper template for design #21006-31_PW. 
Determine where the design will be drawn on the 
white denim; mark the horizontal and vertical center 
lines of the design. Smooth the denim into place on 
the sticky surface of the hooped stabilizer.

Load PaintWork design #21006-31_PW on a USB 
stick. Attach the PaintWork Tool 
#93 with pen adapter #4 to the 
embroidery machine; insert the 
edding 4600 textile pen of into the 
sleeve until the pen tip just touches 
the red pen guide. Flip the guide 
back out of the way, and lower the 
presser foot. Press Start to paint the design.

When complete, remove the denim from the 
stabilizer and press to set the color.

http://www.youtube.com/watch?feature=player_embedded&v=dJshYHXIyIw#!
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Place the white denim rectangle wrong side up on a flat 
surface; lay the trimmed foam core board on top. Fold 
the fabric around the foam core board edges and glue 
them in place to hold the fabric taut. Let dry.

For a finished look, cut a rectangle of blue denim  
1” shorter and narrower than the foam core board. 
Center it on the back of the board, covering the white 
denim edges; glue in place. Let dry.

Turn the fabric-covered foam core board right side up 
and place an embroidered pocket at each corner. Glue 
in place, taking care to put glue only on the back panel 
and the outer edges of the pockets, leaving the center 
pockets free to hold the corners of the desk calendar.

Pencil Cup Wrap
Cut a freezer paper template to fit the pencil cup. It 
should be at least 4” wide, or the embroidered motif 
may need to be smaller. 

Bond Craft Fuse and Fusible Fleece to the wrong side of 
one 5½” x 12” blue denim rectangle. Embroider design 
# 21006-17 in the center of the rectangle.

Press Craft Fuse to the wrong side of the remaining 
5½” x 12” denim piece, and spray the back with 505 
Adhesive Spray. Place the two rectangles wrong sides 
together, matching the outer edges.

Center and press the freezer paper 
template to the layered 5½” x 12” 
denim piece, and then trim the 
fabric around the template.

Bind the lower edge of the wrap, 
starting at the middle of one short 
end and stopping in the middle 
of the other end. Bind the upper 
edge in the same way, leaving 
8” tails for ties at each side and 
overlapping the raw edges of the 
lower edge binding. Tie the wrap 
around the pencil holder.

http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Sewing-and-Embroidery-Machines-us/BERNINA-3-Series-us


Needle-punch, also called dry felting, is a technique 
where loose fibers are punched with sharp, barbed 
needles through a base fabric to create designs. This 
technique can be used on a variety of projects such 
as pillows, purses, jackets, and rugs to add color and 
texture to the surface of the fabric.

Traditionally a hand-worked technique, needle-punch by 
machine is a free-motion technique that is much faster 
to craft by machine. Creating a needle-punch project on 
a BERNINA machine requires a special presser foot and 
attachment: One specifically for the rotary hook models 
(maximum stitch width of 9.0 mm), or one specifically 
for the CB hook models (maximum stitch width of 5.5 
mm). Consult your BERNINA Dealer to make sure you 
purchase the correct version for your BERNINA model.

Background Fabric
Typically worked on wool, other sturdy fabrics such 
as denim or felt also make good backgrounds for 
needle-punched designs. Medium-weight, firmly woven 
fabrics such as silk noil or cotton may be used, but it is 
important not to “over-punch” them. Avoid very dense 
fabrics such as upholstery materials and elastic fabrics 
such as spandex as these are harder for the needles to 
penetrate and may cause the felting needles to break.

Fibers
A wide variety of fibers can be punched into the fabric 
including: 

•	Wool Roving (wool that has been, carded, and 
combed, ready to be spun): The most common fiber 
used for needle punch. Other fibers such as silk and 
cotton are also available as roving.

by	SUSAN BECK

accessory
SPOTLIGHT

•	Soft Yarns: Many yarns work 
well for needle-punch although 
some have netting that must 
be removed before fibers 
apart can be pulled apart. 
Trial-and-error testing is best 
to determine whether selected 
yarns will give the desired look 
to your felted projects.

•	Fabrics: Soft silk and cottons, cut into small “confetti-
like” pieces, can be punched into a background 
fabric. Wools cut into shapes can also be punched 
and melded to a background fabric.
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Designs
Needle-punching is an art form where the artist builds 
the design as he or she punches. Fibers can be punched 
randomly to add color and texture or may be worked 
into specific shapes such as leaves and flowers. Designs 
and shapes can be drawn onto the background fabric 
for the stitcher to follow, or they can be created as 
layers of fibers are punched in place.

Needle
 Punch

 Accessory

http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-rotary-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-CB-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-CB-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-CB-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-rotary-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-rotary-hook-machines-us
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Punching
Don’t let the fact that this is a free-motion technique 
scare you. There are no threads and no stitches to 
regulate, so moving the fabric is very easy and the 
results are fast and fun. Follow these simple steps to 
create needle-punched projects:

•	Loosely place the selected fibers on the background 
fabric in a pleasing arrangement.

•	Quickly move the fabric and punch over the entire 
surface to “baste” the fibers to the background.

•	Next, go back and work each area, punching the 
fibers down as desired. The more you punch, the 
firmer and less soft the shapes will look.

•	Turn the fabric over and punch from the back to 
enmesh the fibers into the fabric, making them more 
secure.

•	Finish the punching process with one more pass on 
the right side of the fabric. Add layers of fiber as 
needed and continue the punching process until the 
desired finished look is achieved. 

Felting Tips
1. Set the machine at a slow to medium speed and 

practice moving the fabric in a consistent, smooth 
manner. The most common problem is using 
fast, jerky movements, which can cause needle 
breakage. Once you master the technique for 
moving the fabric, you’re home free!

2. Use a stiletto or 
chopstick to hold the 
fibers in place as you 
punch them into the 
background fabric.

3. Add additional 
techniques such as 
quilting, beading, and 
couching to a needle-punched piece to add depth 
and dimension to your project.

4. If a specific shape – such as a flower – is desired, 
arrange the fibers in that shape before punching 
them into the fabric.

5. Stitch an outline embroidery design and “color” 
it by punching fibers into individual parts of the 
design. 

6. Use a hand-felting needle to define outlines before 
filling in parts of the design with machine needle-
punching. Hand felting can also be used to add 
intricate design details on top of machine-felted 
areas.

Nine Popular Projects Featuring the 
BERNINA Needle Punch Accessory Set
1.	 Add Punch to Your Projects by Paula Scaffidi 

2.	 Needle Punched Garden by Allison Stilwell 

3.	 Textured Silk Jacket by Nina McVeigh

4.	 Felted Journal by Susan Beck

5.	 Textured Clutch by Susan Fears

6.	 Wool Floral Table Topper  
by Nina McVeigh

7.	 Shades of Silver Clutch  
by Jennifer Gigas

8.	 Red Punch Jacket  
by Faith Reynolds

9.	 Fantasia Floral Wall Hanging  
by Edna Gregory

Bonus Video on the Needle 
Punch Accessory and Techniques
Learn how to use the Needle Punch 
Tool with different types of fibers for 
a "felted" effect in your quilts in this 
informative theQuiltShow.com video.

http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-rotary-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-CB-hook-machines-us
http://www.bernina.com/en-US/Experience/Through-the-Needle-Online/Through-the-Needle-Online-Issue-11
http://www.bernina.com/en-US/Experience/Through-the-Needle-Online/Through-the-Needle-Online-Issue-10
http://www.bernina.com/en-US/Experience/Tips-Tricks-Tutorials/USA/Accessories/Textured-Silk-Jacket/BERNINA-NP-TexturedSilkJacket.pdf
http://www.bernina.com/en-US/Experience/Tips-Tricks-Tutorials/USA/Sewing-Embroidery/Felted-Journal
http://www.bernina.com/en-US/Experience/Tips-Tricks-Tutorials/USA/Sewing-Embroidery/BERNINA-830-Textured-Clutch/BERNINA-830-TexturedClutch.pdf
http://www.bernina.com/en-US/Experience/Tips-Tricks-Tutorials/USA/Accessories/Wool-Floral-Table-Topper
http://www.bernina.com/en-US/Experience/Tips-Tricks-Tutorials/USA/Accessories/Shades-of-Silver-Clutch
http://www.bernina.com/en-US/Experience/Tips-Tricks-Tutorials/USA/Sewing-Embroidery/Red-Punch-Jacket/RedPunchJacket.pdf
http://www.bernina.com/en-US/Experience/Tips-Tricks-Tutorials/USA/Accessories/Fantasia-Floral-Wall-Hanging
http://www.thequiltshow.com/os/bernina_videos_view.php/bernina_videos_id/1030
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by TIMMESA EADS

This cute Farmers Market Tote Bag is easy to 
make! Start with an old pair of pants – cuffed 
or uncuffed – and a half-yard of fabric for the 
ruffles. Embellish the back with embroidery or 
applique and you’re done. You don’t even have 
to hem the top of the bag – it’s the hem of the 
pants leg!

Supplies
•	One pair of pants
•	½ yard of fabric
•	2 yards of 1½”-wide Soft Ban-Rol, webbing, or 

grosgrain ribbon for straps
•	Matching thread
•	Size #80/12 Universal needles
•	Fabric marker
•	Rotary cutting tools (optional)
•	Hemmer foot (BERNINA SIZE Hemmer #66)
•	Gathering foot (BERNINA Gathering Foot #16/16C)

For optional embroidery:
•	OESD designs #NX225 (peppers) and #NX226 

(carrots) from Redwork 1 collection #11511
•	OESD MediumWeight Tear-Away stabilizer
•	Isacord Embroidery thread
•	Embroidery foot (BERNINA Embroidery Foot #26)

For optional applique:
•	Trace the applique pattern (available for free 

download from bernina.com/ThroughTheNeedle)
•	OESD Applique Fuse & Fix
•	OESD LightWeight Tear-Away stabilizer
•	505 Temporary Fabric Adhesive Spray
•	Applique foot (BERNINA Open Embroidery Foot #20) 

Create the Ruffles
Cut the pant legs off just 
below the crotch seam 
and cut away the inseam 
through both layers of 
both legs to create two flat 
pieces of fabric for your 
tote bag.

Cut strips of fabric for the 
ruffles whatever width 
you’d like; I made mine  
4” wide. 

upcyc led
PROJECT

Attach the hemmer foot to your machine and hem the 
top and bottom edges of one ruffle strip to use for the 
uppermost ruffle. Hem one long edge of each remaining 
ruffle strip for a neat finish. Zigzag Hemmer Foot #66 is a 
great option and makes a clean, crisp hem. 

cl ick 
for 
v ideo

Tip: Use a serger to make rolled edges on the ruffle 
strips instead of hemming them.

Farmers Market Bag

http://www.facebook.com/pages/Creative-Sewing-Machines-Inc/153529831362924
http://jeffdorchester.com/qstOld/ban_rol.htm
http://www.berninaneedles.com/_upload/INSWE0234.pdf
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Zigzag-hemmer-foot-61-2mm-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Gathering-foot-en
http://www.embroideryonline.com/p-8438-peppers.aspx?Searchterm=nx225
http://www.embroideryonline.com/p-8439-carrots.aspx?Searchterm=nx226
http://www.embroideryonline.com/p-8439-carrots.aspx?Searchterm=nx226
http://www.embroideryonline.com/p-12096-redwork-1.aspx
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBT35-15
http://www.brewersewing.com/bqss_consumer/productdetailvariant.asp?item=2922-%20%20%20%20%20%20%20%20%20%20%20%20%20%20%20
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Embroidery-foot-26-drop-shaped-us
http://www.bernina.com/en-US/Experience/Through-the-Needle-Online
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBA20-10
http://www.brewersewing.com/bqss_consumer/productdetail.asp?item=HBT15-15
http://www.embroideryonline.com/products/ItemDetail.aspx?ItemCodeID=321
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/-20D
http://www.youtube.com/watch?v=Tm7TZgxYWiI


I S S U E  1 6  •  2 1

Embellish the Bag
Dress up the back of the bag with embroidery or 
applique.

Embroidery
For the embroidered bag, I created my design in the 
BERNINA 830’s Jumbo Hoop. The lettering is in two 
pieces – Eat your and Vegetables – arched vertically 
and horizontally using the Word Art feature. I added 
pepper and carrot embroidery designs from OESD – 
designs #NX225 and NX226 from Redwork 1 collection 
#11511. After composing my design on screen, I hooped 
the back of the pants (the piece without ruffles) with 
a layer of tear-away stabilizer and embroidered them. 
When the stitching was complete I removed the excess 
stabilizer away from the back.

Attach the gathering foot to your machine and 
gather one of the long hemmed edges of the top 
ruffle, stitching about ½” below the finished hem 
edge. Gather the remaining raw edge of each of the 
remaining ruffle strips.stitching about ½” 
from the raw edge. 

The pant leg hems will be at the top edge of the bag; 
decide how tall you want your finished bag to be and 
draw a line to mark the bottom of the bag on each 
pant leg. Cut away the excess fabric below this line, 
leaving ½” for the seam allowance. 

Position your first ruffle on one of the pant legs (for the 
bag front) so the lower edge is about 1” above the raw 
edge at the bottom of the bag. If the strip is too short, 
gently pull to pop a few of the gathering stitches. If the 
strip is too long, that’s fine; you’ll trim the ends later. 

Using an all-purpose presser foot, stitch the ruffle in 
place, sewing over the gathering stitches. 

Position the second 
ruffle above the first 
one, overlapping about 
1”. Stitch into place.

Repeat, covering the 
pants with ruffles, 
ending with the upper 
ruffle.

Applique
Trace the pear and leaf shapes on the paper side of 
the Applique Fuse & Fleece. (The images have been 
reversed so they will appear correctly when appliqued.) 
Cut around the shapes, leaving about ¼” all the way 
around.

Press the fusible side of the Appliqué Fuse and Fix to 
the wrong side of your appliqué fabric. Cut along the 
drawn lines around each shape.

Peel off the paper backing to expose the sticky 
adhesive. Position the applique pieces on the bag as 
desired and smooth in place; the sticky adhesive will 
hold them in position for stitching.

Use a light spritz of 505 Temporary Fabric Adhesive to 
affix a layer of OESD LightWeight Tear-Away stabilizer to 
the back of the bag, behind the applique pieces.

Stitch around the edges of each shape using an open-
toe embroidery foot and a blanket stitch. (If your 
machine doesn’t have a blanket stitch, use a short, 
narrow zigzag or a satin stitch of the desired width.)

When complete, gently remove the excess stabilizer 
from the wrong side.

http://www.youtube.com/watch?v=QrVh0WRwnR8


Timmesa Eads
Everything I know about 
sewing I learned from 
my mother, Sue Shrader, 
who I partner with to run 
Creative Sewing Machines, 
Inc, in Mt Airy, NC.  

I enjoy up-cycling items 
to make fun projects, or 
turning past creations 

into something fun and different. I like to add a 
little pizazz to whatever I make simply so it’ll make 
me smile when I see it. Creating is fun, joyful, and a 
treat to do!

Join our Facebook page to get a glimpse into our 
world. We’d love to have you here!

Construct the Bag
Cut the waistband roll or webbing into two pieces, each 
about 36” long. Position one on each half of the bag, 
about 3” below the 
hemmed edge (which is 
now the upper edge of 
the bag), as shown in 
the photo. Stitch across 
the ends, about ¼” 
from the cut edges. For 
added strength, stitch 
back and forth 3 or 4 
times. Then fold the 
handles up and stitch across the end, about ½” from 
the fold, enclosing the raw ends underneath. 

Baste along the sides of the bag front, catching the 
ends of the ruffles in the stitching. Be careful and make 
sure the strips are flat at the ends and not twisted or 
folded.

Place the front and back of the bag right sides together. 
Seam the sides and lower edge using a ½”-wide seam 
allowance. Be careful not to catch the lower edge of 
the first ruffle in the bottom seam! (Tuck it up inside to 
hold it out of the way while you stitch.) 

Overcast or zigzag the 
raw edges together to 
neaten the inside of 
the bag and prevent 
raveling. 

Tip: If you have a serger, 
use it instead of your 
sewing machine to 
overcast the edges.

Turn the bag right side 
out. You’re done!

•	http://thebobbincase.net
•	http://www.onceuponaquilt.com
•	http://sayitwithstitches.net/blog
•	http://whatsnewatthequiltshop.blogspot.com
•	http://sewvacltd.com
•	http://www.sandissewingconnection.com
•	http://www.thepresserfoot.com
•	http://www.seworiginal.org
•	https://www.shiisaquilts.com
•	http://www.keizerbernina.com
•	http://www.lindastewartcouturedesigns.com
•	http://www.quiltsonthecorner.com
•	http://www.fiberella.com
•	http://www.animasquilts.com
•	http://lunchboxquilts.com
•	http://amandamurphydesign.blogspot.com
•	http://www.kathydelaney.com
•	http://www.kjbartz.com
•	http://www.kate-n-kaboodle.com
•	http://www.nancyprince.com
•	http://scrap-therapy-quilts.blogspot.com
•	http://hummingbird-highway.com
•	http://www.libbylehman.us
•	http://www.branums.com
•	http://rgadesignquilts.blogspot.com
•	http://www.fiberellastudio.com
•	http://www.wendybutlerberns.com

partner
l inks
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http://www.facebook.com/pages/Creative-Sewing-Machines-Inc/153529831362924
http://www.facebook.com/pages/Creative-Sewing-Machines-Inc/153529831362924
http://www.bernina.com/en-US/Experience/Through-the-Needle-Online


The Last Word
A sneak peek at what’s coming in  
Through the Needle ONLINE, Issue #17:

Until May ...
Can you think of a better way to stay warm and dry 
during the coming “April showers” than by staying 
indoors and sewing? What projects do you have 
planned for this spring? We’d love to see what you’re 
stitching! Send e-mail to jo@berninausa.com.

Quick Links
These are the main links featured in this issue; 
see the articles for links to specific products, 
projects, and technique information. Please visit 
our sponsors and contributors for more inspiration, 
information, and stitching fun!

•	bernina.com/ThroughTheNeedle 
•	bernina.com 
•	WeAllSew.com
•	benartex.com
•	embroideryonline.com 
•	bernina8series.com/EN/
•	facebook.com/berninausa
•	rickytims.com/seminars
•	arizonaquiltershalloffame.org/index.

php?option=com_content&task=view&id=103&
Itemid=60

•	sewfromtheheart.com
•	facebook.com/SewFromTheHeart 
•	hummingbird-highway.com
•	scrap-therapy-quilts.blogspot.com
•	sewcreative.com
•	facebook.com/pages/Sew-Creative-Peoria-

Heights/158452290832996
•	creativesewing.com
•	facebook.com/pages/Creative-Sewing-Machines-

Inc/153529831362924

Bottle Labels
Add a fun message 
to a bottle of wine (or 
other beverage) with 
Jen Swearington’s cute 
stenciled labels made 
from vintage fabrics and 
handkerchiefs.

Raw Edge Applique 
– In the Hoop!
Patrice Denault shares her 
technique for digitizing 
raw edge applique designs 
– including placement 
lines for the fabric 
pieces – using BERNINA 
Embroidery Software 6.

April 2013 Special
Ideal Companion
Suitable for both echo and 
free-motion quilting, this presser 
foot also makes it easy to create 
embroidery and thread painting 
with a zigzag stitch. Plus, the 
#44C foot is the ideal partner for 
the BERNINA CutWork Tool!
For April 2013 only, get 25% 
OFF BERNINA Echo Quilting and 
CutWork Foot #44C.
Offer good April 2013 at participating BERNINA 
dealers in the United States. Coupon may not 
be combined with any other offer.

25% OFF

March 2013 Special
Fantastic Fibers
The BERNINA Punch Tool is an 
exciting way to create surface 
design, embellishment and 
dramatic texture. Build felt fabric 
from fibers and create three 
dimensional objects — wonderful 
elements to add to your sewing 
and embroidery projects.
For March 2013 only, get 25% OFF 
BERNINA Needle Punch Accessory 
Set for CB or Rotary Hook 
machines.
Offer good March 2013 at participating 
BERNINA dealers in the United States. Coupon 
may not be combined with any other offer.

25% OFF

Needle Punch 
Accessory Set

Echo Quilting and 
CutWork Foot #44C
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http://www.bernina.com/en-US
http://www.bernina.com/en-US/Experience/Through-the-Needle-Online
http://www.bernina.com/en-US/Experience/Through-the-Needle-Online
http://www.bernina.com/en-US/Experience/Through-the-Needle-Online
http://www.sewcreative.com/
http://www.jennythreads.net/about.html
http://pmegios.com/
http://www.bernina.com/en-US/Products/BERNINA-products/BERNINA-Software/BERNINA-embroidery-software-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-rotary-hook-machines-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Special-sewing-accessories-us/Needle-punch-tool-for-CB-hook-machines-us
http://www.bernina.com/en-US/Meta/Store-locator-en
http://www.bernina.com/en-US/Meta/Store-locator-en
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Echo-quilting-and-CutWork-foot-44C-us
http://www.bernina.com/en-US/Products-us/BERNINA-products-us/BERNINA-Accessories-us/Presser-feet-us/Echo-quilting-and-CutWork-foot-44C-us
http://weallsew.com/
http://www.benartex.com
http://www.embroideryonline.com
http://www.bernina8series.com/EN/
http://www.facebook.com/#!/berninausa
http://www.rickytims.com/seminars
http://arizonaquiltershalloffame.org/index.php?option=com_content&task=view&id=103&Itemid=60
http://www.sewfromtheheart.com/
https://www.facebook.com/SewFromTheHeart
http://hummingbird-highway.com/
http://scrap-therapy-quilts.blogspot.com/
https://www.facebook.com/pages/Sew-Creative-Peoria-Heights/158452290832996
http://www.creativesewing.com
http://www.facebook.com/pages/Creative-Sewing-Machines-Inc/153529831362924
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